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2 FAH-1 H-100   
FOREIGN AFFAIRS MANUAL 

STANDARDS 

2 FAH-1 H-110   
REVISING OR DRAFTING NEW MATERIAL 

(CT:FPH-1;   08-16-2004) 
(Office of Origin:  A/RPS/DIR) 

2 FAH-1 H-111  INTRODUCTION 

2 FAH-1 H-111.1  What Is This Handbook’s 
Objective? 
(CT:FPH-1;   08-16-2004) 

a. This handbook’s objective is to guide you in drafting clearly written 
directives for the Foreign Affairs Manual and the Foreign Affairs 
Handbooks (FAM and FAHs).  The intent is more than just to provide you 
with rules of grammar and formatting guidelines.  This handbook seeks to 
redefine how the Department of State writes its directives.  Consequently, 
the focus is on you, the drafter.  You must understand and adopt the new 
concepts for the Department to achieve its objectives. 

b. Concepts: 

(1) Write for the reader.  Remember, directives provide instructions or 
guidance. 

(2) Write directives in plain language whenever possible.  Section 2 
FAH-1 H-112.1 describes plain language techniques. 

(3) Describe the intent of the directive.  Give the reader a clear sense 
of what you want the reader to do or not to do. 

(4) Specify the laws, regulations, Executive orders, etc. (collectively 
called authorities) that underlie the directive you are writing.  
Section 2 FAH-1 H-114.4 describes how to accomplish this by using 
hyperlinks. 

(5) Specify (by title or office name/symbol) the person or entity 
responsible for taking, authorizing, or prohibiting actions.  Specify 

2 FAH-1 H-110  Page 1 of 29 



U.S. Department of State Foreign Affairs Handbook Volume 2  

in detail the authority such persons or entities have to execute their 
responsibilities. 

(6) Clearly specify whether and how the reader has authority to 
exercise discretion to deviate from instructions or guidance you are 
providing.  Section 2 FAH-1 H-112.2 describes how to do this. 

c. The Office of Directives Management (A/RPS/DIR) is responsible for the 
contents of this handbook.  Send questions to the Office of Directives 
Management e-mail address, EFAM@state.gov. 

2 FAH-1 H-111.2  Scope 
(CT:FPH-1;   08-16-2004) 

These procedures apply to the Foreign Affairs Manual (FAM) and its 
supplemental Foreign Affairs Handbook series (FAH).  (References in this 
handbook to the “FAM” also apply to “FAHs” unless otherwise specified.) 

2 FAH-1 H-111.3  Authorities 
(CT:FPH-1;   08-16-2004) 

a. Executive Order 12866 (Sept. 30, 1993) states that regulations shall 
be “easy to understand” and recognizes Federal agencies as 
“responsible for developing regulations and assuring that the regulations 
are consistent with applicable law . . . .” 

b. The Code of Federal Regulations states that each agency should strive to:  
“provide agency managers with the means to convey written 
instructions to users and document agency policies and procedures 
through effective directives management; provide agency personnel 
with the information needed in the right place, at the right time, and 
in a useful format; . . . .”  41 CFR 102-193.25. 

c. The Government Paperwork Elimination Act (GPEA) (Public Law 105-277, 
Title XVII (44 U.S.C. 3504, note)) requires agencies to “provide -- (1) for 
the option of the electronic maintenance, submission, or disclosure of 
information, when practicable as a substitute for paper; and (2) for the 
use and acceptance of electronic signatures, when practicable.” 

d. The Electronic and Information Technology Accessibility Standards, which 
implement Section 508 of the Rehabilitation Act of 1973, as amended (29 
U.S.C. 794d), require agencies to provide comparable access to electronic 
information to individuals with and without disabilities, unless providing 
access to persons with disabilities imposes an undue burden on the 
agency.  The requirement does not apply to national security systems. 

e. Certain FAM changes may implicate labor-management relations, which 
are addressed primarily in Chapter 10 of the Foreign Service Act of 1980, 
as amended (22 U.S.C. 4101-4118) (regarding Foreign Service 
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employees) and 5 U.S.C. Chapter 71 (regarding Civil Service employees).  
See also, 3 FAM 5000 (Labor-Management Relations).  

2 FAH-1 H-111.4  What Triggers an Update to the 
FAM or FAHs? 
(CT:FPH-1;   08-16-2004) 

Changes to the Department’s organizational structure or the way it conducts 
government business will usually trigger the need to update the FAM or 
FAHs.  Examples of various triggers and the probable items needing updates 
are:  

Triggers Items needing updates 

Change to a bureau/office 
name,  structure, or 
function 

or 

New functions, programs, or 
organizational units 

office symbol, title, or organization 
code 

program or activity 
description/definition 

reporting structure 

operational procedures 

Change to, or the 
interpretation of, a law, 
statute, or regulation (e.g., 
U.S.C., CFR, E.O.) 

Citations thereto or to:  MOU, MOA, or 
Delegations of Authority  

relevant FAM instruction and/or 
guidance  

Out-of-date information policies, procedures, job titles, 
equipment names, contact 
information, form names, protocol, 
terminology, etc. 

2 FAH-1 H-111.5  What Are the New Writing 
Concepts? 
(CT:FPH-1;   08-16-2004) 

a. When writing new or revised FAM and FAH material, you are providing 
instructions and guidance for the reader.  Your instructions and guidance 
may address topics such as carrying out a law, Executive order, or 
provision of the Code of Federal Regulations; accomplishing a task or 
making a decision; or understanding why some action is required and 
when an exception can be granted (see 2 FAH-1 H-112.2).  Write in plain 
language (see 2 FAH-1 H-112.1), as if you are talking directly to the 
reader.  Put yourself in the place of the reader.  Ask yourself, “What do I 
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need to understand?”  Then write the answer to that question.  What you 
write should be clear, concise, and easily understood. 

b. Each subchapter should describe its overall purpose.  Define what the 
subchapter intends to accomplish.  Be clear on the intent. 

c. List the specific legal authorities relevant to your subchapter.  Include 
U.S. Code citations where available.  Create hyperlinks so that the reader 
can go directly to the authorities if necessary.  See 2 FAH-1 H-114.4 for 
details on hyperlinking. 

d. Let the reader know what discretion is available to accomplish the intent 
of the subchapter, what authorities exist to make exceptions and use this 
discretion, and which person or entity (e.g., by title or office 
name/symbol) is authorized to approve this exception.  This is critical.  If 
the reader has no discretion, then say so, and identify any legal or policy 
authority constraining the reader’s actions. 

e. Link responsibilities to a person (by title) or entity (by office 
name/symbol). 

f. Include contact information for readers who do not understand the 
information, or who wish to seek additional guidance.  The preferred 
method is a hyperlink to an office mailbox established for that purpose 
(see 2 FAH-1 H-114.4).  If this is not feasible, provide the name of the 
program office.  Keep this information current. 

g. The Office of Directives Management Intranet Web site offers templates 
to help you format your document.  See 2 FAH-1 Exhibit H-111 for an 
example of FAM formatting. 

 Your document must contain the following— 

Subject Instruction 

Objective Describe what you intend the reader to do.  
Make sure this section is especially clear. 

Scope and 
applicability 

Describe to whom and under what 
circumstances the instructions and guidance 
apply. 

Authorities Cite statutes, Executive orders, etc., that are 
the sources of the directive. 

Individual 
authority and 
responsibilities 

Describe the authority the individual 
exercises in carrying out his or her job (for 
example, “The budget management officer 
certifies funds for payment”).  This individual 
authority derives from policy authorities 
above.  Indicate in this section whether the 
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reader has discretion to deviate from the 
instructions.  See 2 FAH-1 H-112.2 for details 
on which auxiliary verbs to use as you draft. 

Definitions Define terms that do not have clear or 
obvious meanings. 

Specific headings 
for the subject 
matter 

The reader may have to cite all or part of 
your directive.  Use headings to break up 
subject matter and divide instructions and 
guidance into smaller paragraphs. 

h. During the drafting and clearance process, drafters should use MSWord’s 
“Track Changes” function to highlight proposed FAM/FAH edits until other 
editing software is in place (see 2 FAH-1 H-113.1 d.).  In all cases, use 
the approved FAM styles for new or revised material. 

2 FAH-1 H-112  DRAFTING STANDARDS 

2 FAH-1 H-112.1  Use Plain Language 
(CT:FPH-1;   08-16-2004) 

a. Use plain language to improve the reader’s comprehension.  However, 
you have discretion to deviate from plain language when the following 
applies: 

• Using the language of authorities (laws, Executive orders, treaties, 
etc.) 

• Using prior FAM text that has a meaning defined by court decision, 
other adjudicatory body, or longstanding Department usage 

• Writing material designed specifically for subject-matter experts 
such as consular officers, security agents, information management 
officers, human resources specialists, budget and financial 
management officers, etc. 

b. The following are the most notable differences between plain language 
and other writing styles: 

(1) Pronouns as subjects—Whenever possible, use the second person 
“you.”  (“You” may be implicit, as it is in this paragraph.)  Be 
certain the reader understands to whom a pronoun refers.  Use a 
noun if a pronoun would be ambiguous. 

(2) Voice—Use the active voice (for example, “The Executive Office 
grants extended leave requests”) rather than the passive voice (for 
example, “Extended leave requests are granted by the Executive 
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Office.”).  Passive voice may often leave unstated one of the more 
critical regulatory questions—who is responsible for taking action or 
who received the action (for example, “The trip was authorized.”). 

(3) Verbs—Use strong verbs to drive the desired action required in a 
sentence.  Avoid weak verbs that need the support of additional 
modifiers.  For example, “The GSO assists the ICASS council” is 
short, direct, and preferable to “The GSO provides assistance to the 
ICASS council.” 

(4) Precise verbs—Precision is critical when writing FAM directives.  
Use definitive verbs to avoid misinterpretation.  In some cases 
misinterpretation of FAM provisions could lead to lawsuits against 
the Department. 

 NOTE:  See 2 FAH-1 H-112.2 for examples of precise verbs.  

(5) Avoid words and constructions that cause confusion.  Common 
sources of confusion include: 

• Two different terms used for the same thing (car, vehicle, 
auto, conveyance—choose one) 

• Giving an obscure technical or legal meaning to a word 
commonly understood to mean something different (defining 
“car” to include trucks) 

• Strings of nouns forming complex constructions (surface 
water quality protection procedures) 

• Pronouns that don't clearly refer to specific nouns 

(6) Word placement—To reduce ambiguity, keep subjects and objects 
close to their verbs.  You can easily confuse the reader if you put a 
word in the wrong place in a sentence.  For example, “Only the 
Ambassador can authorize extended leave” and “The Ambassador 
only can authorize extended leave” can have different meanings.  
In the first sentence the Ambassador is clearly the sole official who 
can “authorize extended leave.”  But in the second sentence the 
meaning is ambiguous, and the reader could conclude that the 
Ambassador’s authority is limited to approving “extended leave” 
versus other types of leave.  In addition to the word “only,” be 
careful with the placement of other modifiers, such as “always” and 
“just.”  

(7) Sentence length—Keep your sentences as short as possible.  The 
ideal maximum is 15 to 20 words.  For clarity and better 
understanding, consider breaking long sentences into lists or tables. 
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(8) Visual presentation—Plain language recommends using visual 
presentation techniques, such as: 

• Informative headings 

• Short sections 

• One issue per paragraph 

• Vertical lists 

(9) Tables—Use tables to display complex relationships simply. Their 
arrangement helps writers and readers alike to sort out multiple 
options, steps, conditions, and choices. (For a sample table, see 2 
FAH-1 H-111.5 g.)  To create a table, DO NOT USE the “Borders 
and Shading” command under the Format menu.  Instead, choose 
MSWord’s Table menu command— 

1.  Select “Table” from Menu Bar 

2.  Choose “Insert > Table . . . ” 

3.  Insert the number of rows and columns desired 

4.  Click “OK” 

c. For more information on using plain language, see these Web sites: 

• The Plain Language Action & Information Network 

• National Archives Plain Language Tools 

• Writing User-Friendly Documents  

• NIH Plain Language Training (on line) 

2 FAH-1 H-112.2  How To Indicate Whether the 
Reader Has Discretion To Deviate From the 
Instructions  
(CT:FPH-1;   08-16-2004) 

Remember as you draft that you are giving instructions and guidance to the 
reader.  The information must be clear, and the discretion of the reader to 
deviate from instructions must be clear.  Use sentences with the auxiliary 
verbs “must,” “should,” and “may” to describe the level of discretion. 

(1) Mandatory.  Use “must” to advise the reader that he or she has no 
discretion to deviate from the instructions.  In some cases, the 
reader will have no discretion, but another person or entity can 
grant authority to deviate from the instruction.  If so, identify the 
person (by title) or office (by name/symbol) with authority and the 

2 FAH-1 H-110  Page 7 of 29 



U.S. Department of State Foreign Affairs Handbook Volume 2  

circumstances under which the authority may be exercised.  (See 2 
FAH-1 H-111.5d.) 

(2) Recommended.  Use “should” to advise the reader that the 
instruction you are providing is the Department’s preferred 
approach.  However, the word “should” permits the reader to 
deviate if the reader can accomplish the objective in another way.  
Clearly specify how much discretion the reader has, and advise the 
reader if he or she must justify any deviations.  Use the term 
“recommended” if you believe the word “should” will not convey 
these points adequately in the context of the sentence.  Either 
define the word “should” or hyperlink to this definition at the 
beginning of subchapters in which the word appears. 

(3) Advisory.  Use “may” to advise the reader that he or she has the 
option to pursue alternative courses of action.  Use “may” when 
neither law, regulation, nor management policy dictates which of 
several options to follow. 

2 FAH-1 H-112.3  Drafting Header Text 
(CT:FPH-1;   08-16-2004) 

One hallmark of plain language is the use of questions as titles.  Use 
questions as the title when it will help the reader find what he or she is 
looking for.  As this is not always the best course, use the form most 
appropriate for the title.  Try to use keywords or common terms—ones that 
assist the reader to find relevant information or instructions.  Ask yourself, 
“How would I ask or look for this?” and draft your title accordingly.  (See 
Writing User-Friendly Documents.) 

2 FAH-1 H-113  FAM STRUCTURE 

2 FAH-1 H-113.1  Format 
(CT:FPH-1;   08-16-2004) 

a. The FAM’s format is designed to meet E-Government objectives.  This 
format affords speed and flexibility in finding material and the benefit of 
linking to supporting documentation. 

b. Write or revise a FAM subchapter using the official Department templates 
available on the Directives Web site.  These templates contain the correct 
styles, fonts, numbering, and formatting structure.  The following sections 
(2 FAH-1 H-113.1-1 and H-113.1-2) refer to organizing and formatting 
your FAM subchapters properly (including handbook sections). 
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c. Place the most important information first, then follow with your 
supporting material.  This encourages the reader to take specific actions, 
learn about a change, or to read more. 

d. During the drafting and clearance process, drafters and reviewers should 
use the “Track Changes” function of MSWord to show all new and 
removed material. 

1. Go to  –  “Tools” dropdown menu  

2. Choose  –  “Track Changes” function  

3. Select  –  “Highlight Changes . . . ”  

4. Check the box  –  “Track changes while editing”  

5.  Click on  –  “OK” button 

e. Upon completion of the clearance process, we recommend that volume 
coordinators save a copy of their drafts, with changes and comments, to 
their desktop or file server.  You must select the “Accept All (changes)” 
command under the “Tools” menu, “Track Changes” function of MSWord, 
on all original drafts before sending them to A/RPS/DIR. 

1. Go to  –  “Tools” dropdown menu  

2. Choose  –  “Track Changes” function  

3. Select  –  “Accept or reject changes . . . ” 

4. Click on  –  “Accept All” 

 NOTE:  Please ensure that final drafts sent to A/RPS/DIR for posting are 
totally clean of all “track changes” markings and comments. 

2 FAH-1 H-113.1-1  Volume Structure 
(CT:FPH-1;   08-16-2004) 

a. The FAM divides major functions of the Department of State into 
volumes.  Within each FAM volume are chapters, subchapters, and 
sections.  Each chapter number and title appears above its first 
subchapter.  Chapter and subchapter numbers vary by volume.  
Generally, chapter numbers are 000, 100, 200, etc.  For example, 
Chapter 100 has subchapters 110, 120, 130, etc.  Subchapter numbers 
and titles appear centered, in all capitals, at the top of the subchapter's 
first page.  Each subchapter can have major subdivisions, for example 
sections 121, 122, 123, etc.  An example of chapter-through-section 
numbering follows.  (Note:  Style and type specifications are noted to the 
right of the examples that follow.) 
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Example 

               0 FAM 100              H22    
                CHAPTER TITLE    22-pt Verdana bold 

                   0 FAM 110              H20    
                SUBCHAPTER TITLE  20-pt Verdana bold 

 0 FAM 111  SECTION TITLE    H18 – 18-pt  Verdana bold 
b. Below the section level are subsections.  These begin at the .1 level; the 

next subdivision at .1-1.  The FAM refers to all section subdivisions as 
“sections.”  Below the first section level (that is, after the decimal point), 
numbers larger than nine are permissible (for example, 121.35, or 121.1-
13).  Although two further subdivisions are possible ((A) and (i)), avoid 
creating divisions at those levels if possible.  All heading numbers and 
titles are bold and darkblue, as noted in the following subsection 
example. 

Example 

 0 FAM 111.1  Section Title    H16 – 16-pt Verdana bold flush left 

 0 FAM 111.1-1  Section Title       H14 – 14-pt Verdana bold flush left 

c. Foreign Affairs Handbook structure is the same as FAM structure.  
Each chapter, subchapter, section, etc., takes an “H-” in front of each 
number.   

Example 

0 FAH-1 H-113.5-3  Section Title  H14 – 14-pt Verdana bold flush left 

2 FAH-1 H-113.1-2  Paragraph Structure 
(CT:FPH-1;   08-16-2004) 

a. If a section has more than one paragraph, identify each paragraph by a 
letter designation.  If a section has only one paragraph, or one 
paragraph followed by two or more subordinate paragraphs (identified as 
subparagraphs), do not identify the single (main) paragraph with a letter.  
Do, however, identify subparagraphs by numbers or letters in 
parentheses, depending on their degree of subordination. 
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Example 

Descending order of paragraphs and subparagraphs 

Single paragraph level                                      FAM Body Text 

a.  lettered paragraph level                               FAM Body Text abc  

     (1)   first subparagraph level                        FAM Body Text 123 

            (a)  second subparagraph level              FAM Body Text (a) 

 Notes to paragraphs are part of the paragraphs they follow and are flush 
left. 

Example 

NOTE: Follow this handbook’s instructions.         FAM Body Text  

b. Exception to paragraph structure.  In a Definitions section, each 
definition paragraph remains unlettered and is identified by the definition 
itself.  List defined terms in alphabetical order.   

Example 
gigabyte (GB).  A unit of computer memory. 

Uniform Resource Locator (URL).  An Internet address. 

2 FAH-1 H-113.1-3  Change Transmittal (CT) Lines 
(CT:FPH-1;   08-16-2004) 

a. A/RPS/DIR issues changes to the FAM through a change transmittal (CT) 
issuance—formerly known as a transmittal letter (TL).  This record of 
change indicates when the last update was made.  A/RPS/DIR will 
maintain copies of all changes.  If you need to know what text was in 
effect on a specified date, its staff will help you. 

b. Place the CT line (italics, centered, and in parentheses) below each 
subchapter title. (Subchapter head is style H20 and CT line is style 
CT centered.) 

Example 

           0 FAH-1 H-110           H20 
            SUBCHAPTER TITLE  20-pt Verdana bold 

                           (CT:GEN-969;   01-16-2004)   CT ctr – 12-pt Verdana ital 
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c. Place the CT line (italics, flush left, and in parentheses) below any section 
or subsection title that has text immediately beneath it, and specify its 
issuance date. 

Example 

0 FAH-1 H-113.1-3  Change Transmittal (CT) Lines 
(CT:GEN-969;   01-16-2004)                       FAM CT Flush – 12-pt Verdana ital  

d. Unless otherwise noted, FAM changes become effective on the issuance 
date of the change transmittal (CT).  When the effective date of a FAM 
section differs from the CT date, specify the effective date on a line 
immediately below the section or subsection heading (italics, flush left, 
and in parentheses).  

Example 

0 FAH-1 H-113.1-3  Change Transmittal (CT) Lines 
(CT:GEN-969;   01-16-2004) 
(Effective Date:  01-05-2004) 

e. When FAM sections apply to other agencies, identify their scope 
immediately below the section or subsection title (italics, flush left, and in 
parentheses).  

Example 

0 FAH-1 H-113.1-3  Change Transmittal (CT) Lines 
(CT:GEN-969;   01-16-2004) 
(Uniform State/USAID) 

f. When you review previously issued material, and make no changes, 
indicate the date revalidated and the originating office.  

Example 

0 FAH-1 H-113.1-3  Change Transmittal (CT) Lines 
(CT:GEN-969;   01-16-2004) 
(Revalidated:  01-05-2004;   A/RPS/DIR) 

2 FAH-1 H-113.2  Numbering Pages 
(CT:FPH-1;   08-16-2004) 

Number each subchapter in the right corner of the footer using the following 
format.  (Text style:  Footer – 10-pt Verdana flush right.) 
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Example 

1 FAM 110  Page 1 of 15  

To create a footer and numbering scheme— 

1. Go to “View” on the MSWord menu bar and select “Header and 
Footer” to load the Header and Footer menu. 

2. Go to the bottom of the page and mouse click in the boxed footer 
area. 

3. Type the volume and subchapter followed by a double letter space. 

4. On the Header and Footer menu bar click on “Insert Auto Text” and 
select “Page X of Y.” 

5. Highlight entire footer, click “Format” on the menu bar, select 
“Style,” and choose “Footer.”  

6. Finally, click “View” on the menu bar and choose “Normal” to return 
to page view.  

2 FAH-1 H-114  TECHNICAL ASPECTS OF 
DRAFTING 
(CT:FPH-1;   08-16-2004) 

The Department generally follows the standards published in the U.S. 
Government Printing Office’s Style Manual (the GPO Style Manual).  For 
exceptions to GPO rules, see the Executive Secretariat’s Office of 
Correspondence and Records “Ready Reference Guide.” 

2 FAH-1 H-114.1  Abbreviations 
(CT:FPH-1;   08-16-2004) 

In general, refer to the GPO Style Manual (Chapter 9) for accepted forms of 
abbreviations, acronyms, and letter symbols.  For exceptions and short 
forms specific to the Department of State, see the Ready Reference Guide. 

(1) State Department Offices.  Spell out the full title the first time 
you use it and place its office symbol acronym in parentheses 
directly after it.  Reintroduce the full title of the acronym the first 
time you use it in each section, or more often if needed for clarity. 
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Example 

Office of Overseas Operations (DS/DSS/OP) 

regional security office (RSO)   

(2) U.S. and United States.  Use “U.S.” only as an adjective, and 
spell out “United States” when used as a noun. 

Example 

The United States announced the closing of a consular office. 

(3) Department of State.  Do not use “DOS” for the Department of 
State.  Use “State” or “the Department.” 

(4) Public Law.  Spell out the words; do not abbreviate. 

2 FAH-1 H-114.2  Capitalization 
(CT:FPH-1;   08-16-2004) 

In general, follow the examples below for capitalizing names and titles.  

Rule Example 

Capitalize formal titles and 
organized bodies or entities. 

Ambassador Smith briefed the 
Marine security guards in the 
Embassy courtyard. 

Do not capitalize generic or 
functional titles. 

regional security officer;  
ambassador;  consular officer 

Capitalize names of regions, 
localities, and geographic 
features. 

the Far East;  the North Pole;  
Middle Eastern;  the Western 
Hemisphere 

Capitalize Internet, Intranet, 
and Web, but lower case the 
word “site.” 

The Department has an Internet 
Web site as well as an in-house 
Intranet site. 

Capitalize the proper or full 
names of organizations, 
bureaus, or offices. 

The front offices for the Bureau of 
Administration and the Office of 
Inspector General are on the sixth 
floor. 
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2 FAH-1 H-114.3  Citing FAM Materials 
(CT:FPH-1;   08-16-2004) 

a. Where a section references material outside the FAM, identify that 
material so that DIR can provide a hyperlink to it.  (See 2 FAH-1        
H-114.4.) 

b. How you cite a reference depends on the document. 

(1) Volumes use volume number and acronym, plus section or 
subsection. 

Example 

1 FAM 123   or   6 FAM 469.3-2 

(2) Handbooks use volume number, handbook acronym and number 
(separated by a hyphen), then the section or subsection number 
(preceded by an “H-”). 

Example 

5 FAH-1 H-456 

 (3) Exhibits and appendices use the volume or handbook style from 
above, two letter spaces, “Exhibit,” “Appendix,” “Notes,” or 
“Procedural Notes,” with the section or subsection number followed 
by a comma, then the document title. 

Example 

4 FAM  Exhibit 225.2, Title;    or 

4 FAH-3  Exhibit H-525.3, Title;    or 

9 FAM  Appendix K, Title 

c. Do not start a sentence with a reference.  Precede the reference with at 
least one word or article.  For example:  “See 2 FAM 1111.3 for the scope 
of these directives.” 

d. You may let the formatting split a reference by having one part begin 
near the end of the line and continuing on the next line. 

2 FAH-1 H-114.4  Adding Hyperlinks 
(CT:FPH-1;   08-16-2004) 

a. A hyperlink is an electronic Web tool that provides direct access from one 
piece of information to another, regardless of their respective locations.  
Where a FAM section has related FAH material, identify the specific FAH 
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reference so that DIR can provide a hyperlink to that handbook material 
(see 2 FAH-1 H-114.3).  For example, DIR will hyperlink rules on travel 
contained in 6 FAM to guidance on MEDEVACs, found in 3 FAM.  
Additionally, DIR will link a description of an emergency action plan (EAP) 
found in 12 FAM to the instructions found in 12 FAH-1 for setting up an 
EAP. 

b. DIR currently adds links to the following sources: 

• U.S.C. 

• CFR 

• INA 

• FAM / FAH 

• OMB Circulars 

• Public Law 

c. DIR can add customized links.  If you, as volume coordinator, need a new 
link, just e-mail the DIR volume analyst and request one.  Provide a 
keyword or phrase for each link (e.g., Vienna Convention on Consular 
Relations) and give the URL of the link (for example, 
http://www.un.org/law/ilc/texts/consul.htm).  DIR will add the links 
throughout the volume.  If the URL changes in the future, DIR can update 
the link throughout the FAM without rewriting entire volumes.  This saves 
time for everyone involved in the revision process. 

2 FAH-1 H-114.5  Using Numbers 
(CT:FPH-1;   08-16-2004) 

Follow these guidelines when citing numbers and numerical form. 

Rule Example 

Spell out numbers below 10 in a 
sentence. 

The program places emphasis on 
three vital areas. 

Use figures for numbers 10 and 
above. 

A committee of 15 RSOs rewrote 
21 subchapters. 

For two or more numbers in a 
sentence, if one is above 10, then 
use figures for each number. 

The embassy constructed 14 
staff houses and 6 guard towers. 

Spell out ordinal numbers first 
through ninth for time or location. 

The first meeting convenes on 
the third floor in the second 
week of June. 

Use figures for units of In the first 8 hours, over 40 
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measurement, time, or money. percent of the officers donated 
at least $75 each. 

Use figures for monetary amounts 
less than 1 million. 

The court distributed the 
remaining $250,000 to 100 
stockholders. 

Spell out numbers at the 
beginning of a sentence. 

When possible, recast the 
sentence in the active voice.  

Twelve years passed before he 
returned to the bureau.  

He returned to the bureau 12 
years later. 

Use figures to express mixed 
fractions, but spell out fractions 
standing alone. 

The report was 9-1/2 pages 
long, but the synopsis was only 
one-tenth of that. 

For percentages, use a figure and 
spell out the word “percent.” 

There is a 30-percent chance of 
rain tomorrow. 

With two separate figures, use 
“percent” only once. 

There is a 20- to 25-percent 
chance of rain today. 

Use the words “million,” “billion,” 
and “trillion” for large numbers. 

150 million people, $12.5 billion,  
6.5 trillion stars 

Use numerals rather than letters 
for figures or illustrations. 

The graph in Figure 2 displays 
the rate of increased 
compensation. 

Use numerals to explain 
sequential steps, especially when 
giving instructions. 

1.  Type in the Web address.  
This will bring you to our home 
page. 

2.  Mouse click on “Contact Us.” 

3.  Type in your message. 

2 FAH-1 H-114.6  Time of Day 
(CT:FPH-1;   08-16-2004) 

Follow these guidelines when citing time of day.  See also GPO Style Manual 
(Chapter 12) for measurement and time. 

Concept Example 

Use a.m. and p.m. with a 12-hour 
clock cycle. 

Send us your report by 
10:30 a.m. Monday. 
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Omit minutes when citing time on 
the hour. 

Send us your report by 10 a.m. 
Monday. 

Always write “noon” and “midnight” 
(and NOT “12 a.m.” or “12 p.m.”). 

The passport office must 
receive the application by noon 
tomorrow. 

2 FAH-1 H-114.7  Dates 
(CT:FPH-1;   08-16-2004) 

a. Write out specific dates within sentences or as part of a heading. 

Concept Example 

Date within a sentence We received advanced notice of 
the inquiry on June 15, 2003. 

Date in a heading January 15, 2003 

The Director of Operations 
U.S. Department of State 
Washington, D.C.  20520 

b. Use figures when referring to specific dates. 

Example 

the 4th of April (specific month) 

but, the fourth day of the month (nonspecific month) 

2 FAH-1 H-114.8  Punctuation 
(CT:FPH-1;   08-16-2004) 

a. Apostrophe.  Use an apostrophe to show possession. 

(1) Place an “ ’s ” at the end of a singular word, or at the end of a 
plural word that does not end in “s.” 

Example 

The Court’s decision on the women’s claim is under review. 

(2) Place the apostrophe only at the end of plural words ending in “s.” 
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Example 

We updated our analysts’ research strategies this quarter. 

 (3) With a possessive involving two subjects, determine whether both 
parties own the item together or separately. 

Example 

State and AID’s policy regarding . . . . 

 In this case, State and AID share the same policy.  In the next 
example, we have two different administrations. 

Example 

Carter’s and Reagan’s administrations were  . . . 

 Exception:  Don’t place an apostrophe after names of countries 
or organized bodies ending in “s.” 

Example 

a United Nations meeting;  the United States policy 

b. Bullets.  Use bullets to highlight key thoughts or for a short list of items.  
Bulleted items should not be complete sentences.   

Example 

Any proposed new organizational structure should strive 
to achieve a proper balance among: 

• Mission needs 

• Efficiency of operations 

• Effective employee utilization 

c. Colon.  In general, refer to GPO Style Manual (Chapter 8) for accepted 
use of colons. 

d. Comma.  Use a comma: 

(1) To join two complete sentences with “and,” “or,” “but,” “yet,” and 
so on. 

Example 

State enacted needed improvements, and these actions benefit 
all U.S. Government agencies at posts abroad. 
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 (2) After introductory words and phrases. 

Example 

By July 1998, the new program was ready for review. 

Furthermore, policy alone cannot revoke this decision. 

 (3) Between two or more consecutive adjectives instead of the 
conjunction “and.” 

Example 

The program is a simple, cost-effective method of purchasing. 

 (4) Before the word “and” or other conjunctions in lists of three or more 
words, letters, phrases, or figures. 

Example 

We have more control, lower turnover, and better relations. 

 (5) With nonessential or secondary information. 

Example 

They studied the best data-gathering practices, sending 
questionnaires across the world, and presented the findings 

and recommendations to management. 

 (6) In dates, between the day and the year. 

Example 

You must submit the complete report by May 22, 2004. 

 Exceptions:  Do not use a comma when the day is missing, or 
when referring to a specific year. 

Example 

The new program began in May 2004. 

This policy will expire in the Year 2004. 

e. Em dash.  Use an em dash to give a longer pause than a comma, 
although two hyphens are also acceptable.  Also use the em dash: 

(1) To interrupt a thought. 
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Example 

We agreed that we could provide a more pleasing environment 
than a separate building—away from headquarters. 

 (2) To emphasize a point, or to separate your emphasis from the main 
part of the sentence. 

Example 

Employee satisfaction rates rose to 85 percent--meeting our 
internal goal--with the survey return rate reaching 55 percent. 

 (3) To summarize a series of items at the end of your sentence. 

Example 

A second attempt would require additional office space—fully 
supplied with costly furniture and equipment. 

f. Hyphen.  Use a hyphen: 

(1) With a prefix, if the first letter of the base word is capitalized. 

Example 

pro-Marxist,   anti-American 

 (2) With compound modifiers. 

Example 

We had a face-to-face meeting. 

Our reviewer is a part-time contractor. 

Exceptions:  Do not hyphenate: 

(a) Compound modifiers using “very” and adverbs ending in “ly.” 

Example 

The Department participated in very successful meetings. 

A quickly forgotten decision is no decision at all. 

(b) Compound predicate adjectives: 

Example 

Our reviewer works full time. 
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g. Semicolon.  In general, refer to GPO Style Manual (Chapter 8) for 
accepted use of semicolons. 

2 FAH-1 H-115  PUBLICATION STANDARDS 

2 FAH-1 H-115.1  FAM Template 
(CT:FPH-1;   08-16-2004) 

a. Create or modify all FAM materials in a document based upon the FAM 
templates available from A/RPS/DIR. 

b. To update an existing volume: 

(1) Access the document that you need to update, plus the new 
FAM/FAH volume template, from the DIR Web site, and save them 
to your desktop; 

(2) Make any needed additions, deletions, or changes to the document 
text;  

(3) Copy and paste the entire revised document text into the new 
FAM/FAH volume template; and 

(4) Apply the new FAM styles (located on the style menu button bar) or 
from the application’s Style dropdown menu. 

c. When creating a new subchapter, the coordinator can copy, populate, and 
save the FAM template as a document. 

2 FAH-1 H-115.2  Fonts and Typefaces 
(CT:FPH-1;   08-16-2004) 

a. The official versions of the FAM and FAHs use electronic-based fonts for 
their publishing standards.   

b. The FAM uses Verdana for both heads and text.  Body text, table text, 
and CT lines are 12 points; and heads vary from 14 to 22 points within 
chapters.  (The FAM/FAH Templates include preformatted styles for both 
heads and text and are available as menu buttons and from the 
application’s Style dropdown menu.) 

c. Visual aid to readers:  Although Verdana is a proportional font, place two 
letter spaces between sentences in normal text. 

d. Bold—Use bold for emphasis. 

e. Italic—Use italics to show new or revised words, sentences, or sections.  
Do not italicize entirely new or significantly revised subchapters.  Also see 
the GPO Style Manual (Chapter 11) for other uses of italics. 
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f. Text styles are flush left, single-spaced, with 6 points of space before and 
after each paragraph.  The text styles most frequently used are: 

(1) FAM Body Text (Text):  The paragraph style following a section or 
subsection heading; used when only one paragraph is needed. 

(2) FAM Body Text abc (Text abc):  The basic style for the initial 
lettered paragraph level; used for multi-paragraph text following a 
section or subsection heading. 

(3) FAM Body Text 123 (Text 123):  A numbered first subparagraph 
level style; used as a subset of the FAM Body Flush or FAM Body 
abc paragraphs. 

g. Section 2 FAH-1 H-113.1-1 partly describes heading styles.  They are 
flush left and have two letter spaces between the number and title. 

h. Underline—Use underlines only in forms to show the reader where to fill 
in information. 

Example 

__________________________________ 

Signature 

Address:  _______________________________ 

2 FAH-1 H-115.3  Using Color 

(CT:FPH-1;   08-16-2004) 

a. The FAM structure uses color to enhance the user’s reading and retention 
of information and to help the reader visualize information.  When 
printing in black and white, the color text prints as black or dark grey. 

b. A/RPS/DIR uses color text as an additional signal to identify specific FAM 
information.  The Electronic and Information Technology Accessibility 
Standards, which implement Section 508 of the Rehabilitation Act of 
1973, as amended (29 U.S.C. 794d), prohibit using color alone to identify 
information (see 36 CFR 1194.21(i)).  Standard FAM colors: 

(1) Heads are darkblue.  This contrasts with standard text, which is 
black.  (Heads are in bold and vary from 14 points to 22 points.  
Use template buttons H14 to H22 to set style and color.) 

(2) New or revised material is darkmagenta and in italics, for 
example,  Published changes show both in darkmagenta and 
italic.  (Use template button Change to set style and color.) 

(3) Change transmittal (CT) lines (formerly transmittal letter (TL) 
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lines) are saddlebrown and in italics.  “CT” also signals them. (Use 
template buttons CT Centered and CT Flush to set style and color.) 

(4) The color firebrick is used for emphasis beyond bolding or for 
contrast in figures or charts.  (Use the template button 
Emphasis to set style and color.) 

 Note:  The four colors chosen here were taken from the Browser Safe 
Web Pallet and do not precisely match the standard Windows pallet. 

2 FAH-1 H-116  FAM CLEARANCE PROCESS 

2 FAH-1 H-116.1  Drafting Bureau or Office 
Clearances 
(CT:FPH-1;   08-16-2004) 

a. Senior management of each bureau or independent office typically 
assigns responsibility for obtaining directives clearances to the volume 
coordinator, who may in turn assign this responsibility to the various 
drafting officers.  If you do not know how this clearance process works in 
your organization, contact your volume coordinator or senior 
management.  For the names of volume coordinators and their clearance 
responsibilities, check A/RPS/DIR’s Web site.  

b. Generally, you (as a drafting officer) will seek clearances for new or 
revised directives within your bureau or office before seeking other office 
clearances.  However, depending on your circumstances, you may seek 
the views of subject matter experts outside your organization as you 
draft.  In the case of personnel regulations or directives, or any other 
regulations that may affect the terms and conditions of employment, the 
drafting officer may wish to contact DGHR/PC/LM early in the drafting and 
clearance process with respect to consultation or negotiation with 
employee unions.  (See also 2 FAH-1 H-116.5.)  Your bureau or office 
may or may not have a policy on this.  Check with your volume 
coordinator to be sure. 

c. Upon obtaining all drafting bureau or office clearances, the volume 
coordinator is ready to seek required clearances from outside the 
organization—i.e., other Department bureaus or offices, and possibly 
other agencies.  In most organizations, the volume coordinator handles 
all external clearances. 
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2 FAH-1 H-116.2  Internal Department Clearances  
(CT:FPH-1;   08-16-2004) 

a. Upon obtaining all drafting bureau or office clearances, the volume 
coordinator provides A/RPS/DIR with a copy of the draft in the required 
format (see 2 FAH-1 H-110 Exhibit H-111).  On a separate page of the 
draft, list all other Department offices you are asking to clear, and 
indicate if any of those have already cleared—L and OIG normally must 
be included.  (OIG is a mandatory review and comment office, but does 
not “clear” Department directives.)  

b. A/RPS/DIR will post the draft on its Web site and immediately alert all 
Department executive offices and volume coordinators that a proposed 
directive is available for review and comment.  The date the alert is sent 
is called the “alert date” and the posting period is normally 30 calendar 
days. 

c. The executive office representative or the volume coordinator for a 
clearing bureau or office must alert everyone in their organization who 
may wish to comment on the posted draft.  The representative or the 
volume coordinator for the clearing bureau or office must compile and 
consolidate all comments received.  This is an important function.  
Consolidation establishes one bureau or office position on the draft and 
speeds the clearance process. 

(1) The executive office representative or volume coordinator for a 
demurring bureau or office then submits the consolidated 
comments to A/RPS/DIR.  DIR will immediately send the comments 
to the drafting bureau’s volume coordinator and post the comments 
to DIR’s Web site. 

(2) If A/RPS/DIR receives comments, its staff will request the drafting 
office to review and respond to those comments, and work out any 
differences.  The drafting office may receive an additional 30 days 
to reach a compromise. 

(3) If a compromise is not reached in 60 calendar days from the 
original posting of the draft (see 2 FAH-1 H-116.2 b.), A/RPS/DIR 
will report the impasse to the Standing Committee on Directives, 
and post the impasse issues on DIR’s Web site. 
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2 FAH-1 H-116.3  Other Agencies (External) 
Clearances  
(CT:FPH-1;   08-16-2004) 

a. The external clearance process is identical to the internal (Department) 
process above except that, when a FAM change requires external 
clearances, the drafting office: 

(1) Must list both the internal (Department) and external clearances on 
a separate page of the draft; and 

(2) Must indicate when it intends to seek each external clearance 
during the 30-day review period or thereafter. 

b. External reviews occurring after the 30-day review period may result in 
substantive changes to the draft text.  In the event of substantive 
changes, the drafting office must resubmit the revised draft to A/RPS/DIR 
for an additional posting.  Normally, this posting period is 30 calendar 
days.  However, the drafting office may request an expedited internal 
review. 

2 FAH-1 H-116.4  Expedited Reviews 
(CT:FPH-1;   08-16-2004) 

a. The drafting bureau or office volume coordinator may request an 
expedited review if: 

(1) The subject matter is not controversial; or 

(2) The directive requires immediate publication. 

b. The A/RPS/DIR FAM supervisor can set an expedited review period after 
discussing the matter with the volume coordinator.  The expedited review 
normally should be a period of 5 business days. 

c. A/RPS/DIR will alert via e-mail all volume coordinators that it has posted 
an expedited request requiring all clearances by the date specified.  

d. Any clearing bureau or office may request A/RPS/DIR to extend the 
expedited review period.  The A/RPS/DIR FAM supervisor can reset the 
period after discrepancies, if any, are discussed with the drafting and 
clearing organizations. 

2 FAH-1 H-116.5  Final Steps 
(CT:FPH-1;   08-16-2004) 

a.  If the draft would modify personnel policies or practices, or affect terms 
and conditions of employment for employees who are represented by a 
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labor union, the volume coordinator is responsible for providing the draft 
to the Chief, Labor Management Relations (DGHR/PC/LM) following the 
internal and external clearance process but in advance of publication.  
The draft provision may not be published until DGHR/PC/LM has cleared 
it.  See 3 FAM 5112.1 b. 

b. When the draft is fully cleared and the volume coordinator has given final 
approval, DIR will publish the draft as the new or revised FAM section. 

2 FAH-1 H-117 THROUGH H-119  
UNASSIGNED 
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2 FAH-1 Exhibit H-111   
FAM Format  

(CT:FPH-1;   08-16-2004) 
(Office of Origin:  A/RPS/DIR) 

0 FAM 000  Purpose of Standards  
(CT:FPH-1;   08-16-2004) 
 (Uniform State/USAID/Commerce/Agriculture) 

Please note that the FAM style and layout, including fonts and select colors, 
are designed primarily for electronic use.  Printing the material in either 
color or in black and white will produce a legible copy. 

0 FAM 000.1  Using Color  
(CT:FPH-1;   08-16-2004) 
 (Uniform State/USAID/Commerce/Agriculture) 

a. The FAM structure uses color to enhance the user’s reading and retention 
of information and to help the reader visualize information.  When 
printing in black and white, the color text prints as black or dark grey. 

b. A/RPS/DIR uses color text as an additional signal to identify specific FAM 
information.  The Electronic and Information Technology Accessibility 
Standards, which implement Section 508 of the Rehabilitation Act of 
1973, as amended (29 U.S.C. 794d), prohibit using color alone to identify 
information (see 36 CFR 1194.21 (i)).  Standard FAM colors: 

(1) Heads are darkblue.  This contrasts with standard text, which is 
black.  (Heads are in bold and vary from 14 points to 22 points.  
Use template buttons H14 to H22 to set style and color.) 

(2) New or revised material is darkmagenta and in italics, for 
example,  Published changes show both in darkmagenta and 
italic.  (Use template button Change to set style and color.) 

(3) Change transmittal (CT) lines (formerly transmittal letter (TL) 
lines) are saddlebrown and in italics.  “CT” also signals them. 
(Use template buttons CT Centered and CT Flush to set style and 
color.) 

(4) The color firebrick is used for emphasis beyond bolding or for 
contrast in figures or charts.  (Use the template button 
Emphasis to set style and color.) 
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 Note:  The four colors chosen here were taken from the Browser Safe 
Web Pallet and do not precisely match the standard Windows pallet. 

0 FAM 000.2  Fonts 
(CT:FPH-1;   08-16-2004) 
 (Uniform State/USAID/Commerce/Agriculture) 

a. The FAM uses electronic-based fonts:  Verdana for both headers and text. 

b. Visual aid to readers:  Although this font is proportional, place two letter 
spaces between sentences in normal text. 

0 FAM 000.3  FAM Styles 
(CT:FPH-1;   08-16-2004) 
 (Uniform State/USAID/Commerce/Agriculture) 

a. The selected FAM styles contain formatting that will work in most cases.  
(To see FAM styles, go to the “Format” menu, and select “Style….”)  FAM 
drafting officers should begin by creating a separate draft using one style 
(“normal”) for all their text.  Then, using the templates that DIR has 
provided, copy and paste changes into the template.  Finally, format the 
new material using the FAM styles from the template style palette. 

b. You can find specifications for FAM styles by viewing them in the Style 
window under the “Format” menu, or in the part of this handbook which 
outlines style standards. 

c. The predominant text styles are FAM Body Text, FAM Body Text abc (such 
as this lettered paragraph), or FAM Body Text 123—indented and 
numbered in parentheses.  Styles for a lower level, centering text, text 
with bullets, and table text are also available. 
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